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Meshes in Object ModeMeshes in Object Mode

In this section we’ll cover the following topics:

 How to create and delete mesh primitives such as cubes, spheres  
  and cones.
 How to set the initial properties of primitives. 
 How to adjust the units of measurement. 
 The purpose of the 3D cursor. 
 How to adjust an object’s origin. 
 How to resize, rotate and move mesh objects.
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When constructing a scene 
we often start with one or 
more primitives. 

We have some control over 
the initial appearance of 
these primitives so we can 
adjust some of their 
characteristics to suit our 
requirements.

When we start a new project, Blender automatically adds a Cube. We can see from the 
orange outline that the Cube is also selected. 

When working in the 3D Viewport, we can deselect an object by 
clicking in an empty area of the scene.
We can select an item by left-clicking on it.

To delete a selected object, press either the Delete key or the X 
key. Using Delete deletes the item immediately, but X requires 
con�rmation before the deletion is actioned.

It’s also useful 
to know that 
any action we 
perform can be 
undone by 
pressing Ctrl Z. 
For example, if 
we have 
deleted the 
Cube but then 
decide we 
want to keep it 
instead, we 
need only 
press Ctrl Z to 
have it 
restored.

The �rst 
option is to 
choose
Add>Mesh 
from the 
Viewport’s 
main menu 
and then 
choose 
from the 
submenu 
list of 
primitives.

The second option is to choose
Shift A to create the same menu but 
this time as a popup. 

To add a new 
primitive to 
our scene, we 
need to use a 
menu option.

There are 
two ways to 
do this. 

Selected
Cube

Click in empty
space to

deselect all

Click over an
item to 
select it

Delete

Immediate
deletion

X

Requires
con�rmation

1

2

Select required
primitive

AShift Popup
menu
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NOTE

We’ll start by creating a Plane, the �rst of the listed primitives and 
also the simplest with only four vertices, four edges and a single 
face. Remember, a new object is always placed over the 3D cursor.

Many operations we perform during modelling creates a Last Op 
panel (also known as the Operator panel) in the bottom left of the 
3D Viewport. This allows us to adjust various parameters of the 
operation we’ve just performed.

The �rst parameter for the Plane is Size 
which speci�es the length of each side. If we 
change the value here, the Plane itself will 
change size.

Generate UVs 
refers to 
texturing and 
will be 
discussed in a 
later chapter. 

Align determines which z-axis the mesh is 
aligned along. By default it is the World’s z-axis, 
but if we change this to View (whose z-axis 
points out of the screen), the Plane aligns 
directly with our viewpoint.

1

2
Plane created
over the 3D

cursor

Last Op
panel for 
Add Plane

A Last Op panel 
only exists until 
another 
operation is 
performed at 
which point it is 
replaced by a 
new Last Op 
panel.

5m Plane
increases

in size

      The 3D Cursor 
option will be 
discussed later

The next set of values, labelled Location, sets the position of the
plane by moving it so that its origin is at the speci�ed location. In 
the example below the plane is moved so that its origin is at 
location (3,-1,2). 

Finally, Rotation speci�es the plane’s rotation about the x, y and z
axes. Normally, this will be measured from the plane’s own global
axes. Rotation is measured in degrees by default. Below a plane is 
rotated 45o about its y-axis. 

3
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2

Location X 3
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Z

Y

2

Rotation X 0
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Z

Y

0

45o

Plane’s global y
-axis

Plane’s original
position

Plane’s new

position
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If we delete our plane and then create a new plane we’ll see that 
Blender has remembered the last Size setting and has created 
this new plane with sides 5 metres in length but the Location and 
Rotation values are reset.

New
plane

5m

Once we’ve selected Add>Mesh>Cube from the 3D Viewport’s menu,
we can see that the cube o�ers the same initial properties in the 
Last Op panel as the Plane:
Size, Generate UVs, Align, Location and Rotation.

After deleting the Cube we can add the next mesh option, Circle. 
This creates a shape made only of vertices and edges. There are 
no faces. But the Last Op panel has some additional options. 

Last Op
panel

Cube

Circle

New
options

Vertices gives the number of vertices around the circumfrence of
the circle. If we reduce this value the shape becomes less circle-
like.

Vertices 9 Vertices 3

Radius sets the radius of the circle. Fill Type o�ers options to 
create one or more faces for the inner part of the circle. Ngon �lls 
the circle with a single face. Triangle Fans creates a set of tris (3
edge faces) meeting at the circle’s centre. 

Fill  Type Ngon ∨ Fill  Type Triangle Fan ∨

To view the faces
press the TAB key to
enter Edit Mode

UV Sphere is the next mesh option. The Last Op panel has two 
new options. These are Segments and Rings. The faces that 
make up a single vertical loop is a segment. Faces that make up 
a single horizontal loop is a ring.

Segments 32

Rings 16 Segment

Ring

       View the structure 
of the sphere in Edit 
Mode 

     Vertices, Radius and 
Fill Type values will be 
reused by any later 
Circles

     Segment, Ring and 
Radius values will be 
reused
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Cap Fill Type determines the type of face used to �ll the top and 
bottom of the cylinder (ngon or tris) or to leave them un�lled. 

The Ico Sphere mesh is constructed from tris. The only new Last 
Op panel option is Subdivisions which, in e�ect controls how 
many tris are used to create the sphere. 

Subdivisions 2

The Cylinder has some features similar to the Circle since the top
and bottom of the cylinder are, in e�ect circles. This means that
some of the Last Op panel options are similar to those 
of the Circle.

Reducing the Vertices value gives a less rounded shape.
Increasing the Vertices makes the curve smoother.

Vertices 3 Vertices 51

Radius sets the radius 
of the cylinder.

Radius 0.4 m

The Depth setting adjusts the height 
of the cylinder.

Depth 0.56 m

Base Fill Type Nothing

The Cone mesh’s options are mostly familar but they include two 
Radius values.  

     Subdivisons and 
Radius values will be 
reused

     Subdivisons and 
Radius values will be 
reused

     Vertices, Radius, Depth 
and Cap Fill type values 
will be reused
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Radius 1 adjusts the width of the Cone’s base.

Radius 1 2 m

Radius 1

Radius 2 adjusts the width at the top of the Cone. For any value
other than zero, we no longer have a true cone shape with the 
mesh acquiring a top cap.

Radius 2 0.5 m

Top cap

Radius 2

Base Fill Type determines how the base and top caps are handled 
(options being: none, ngon, or tris). Below, we see the result of the 
caps having been removed.

Base Fill Type Nothing

Vertices allow us to create a pyramid shape (values 3 or 4) or a 
very smooth curved cone shape (value 100).

Vertices 3 Vertices 100

Depth sets the height of the Cone.

Depth 0.5 m Depth 5 m

The Torus is a doughnut-shaped mesh with many unique options. 

     Vertices, Radius1, Radius2, 
Depth  and Cap Fill Type 
values will be reused
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The option Major Segments refers to the number of faces that
make up a horizontal loop. Minor Segments refers to the number
of faces that make up a vertical loop.

Minor Segments
loop

Major Segments
loop

Reducing the Minor Segments to 3 gives us the shape shown 
below left. Reducing the Major Segments to 3 as well, gives us 
the shape shown below right.

Major Segments 3Major Segments 48

Minor Segments 3 Minor Segments 3

The Major Radius is the distance from the centre of the Torus to
half way through the solid ring.
The Minor Radius is half the width of the outer ring.

Major
Radius

Minor
Radius

By adjusting the Major and Minor Radius values we change the 
overall  size of the Torus, the size of the hole in the middle and the
thickness of the Torus. 

Major Radius 1.2m

Minor Radius 0.25m

Major Radius 0.3m

Minor Radius 0.25m

An alternative method of resizing the Torus is to select the 
Dimensions Mode’s Exterior/Interior option This changes the 
two values displayed below to Exterior Radius and the Interior 
Radius.

1

2
Changes

to

The radii measured by Exterior Radius and Interior Radius are 
shown below.

Interior
radius

Exterior
radius
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Because of the many options available when setting up a Torus,
Blender o�ers a way of saving and naming a set of attribute 
values so that another matching Torus is easily created. To do this 
we must �rst set all the necessary Torus values and then click on 
the + sign to the right of Operator Presets in the Command 
Settings panel.

This opens a new panel where we can specify a name for the 
current value settings. When another Torus is added, the name
can then be selected to apply the associated settings to the Torus.

The next mesh option, Grid, may look identical to the Plane 
mesh but if we look at its structure in Edit Mode, we can see that 
it is constructed from many more faces.

Even if we haven’t saved the 
various Torus settings in the 
way described, any new Torus 
will make use of the current 
settings of the following 
parameters:

 Major Segments
 Minor Segments
 Dimensions Mode
 Radius settings
  

Grid’s Last 
Op panel 
options 
allow us to 
specify the 
number of 
faces in both 
the x and y 
directions. 

X Subdivisions, 
Y Subdivisions 
and Size 
settings are 
reused by 
subsequent 
Grids. 

The �nal mesh is a monkey head - a�ectionately known as 
Suzanne. Although not a true primitive, it is often used to show 
o� various features of Blender. 

When adding
another 

torus

1

2

1

2

Clicking on the - icon will
delete the last named preset
to have been used.

Deletes the last
named preset
from the list

A Grid is made 
from many faces

Tab Edit Mode/
Object Mode

Number of
faces in each

direction
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When creating a mesh we should always go for the minimum number of faces we require since not only will we reduce memory and 
processing requirements, but this can also make the modelling process much easier when we are working in Edit Mode. For example, 
one of the Grids below is created with 10 faces while the other has 100. In the modelling process we want to raise one end of the grid. 
Both end up with exactly same result but one takes a lot less e�ort for both the modeller and the machine.

One situation where we might be tempted to increase the 
number of faces is when creating a curved surface. For example, 
we can see that the second sphere below looks more curved than 
the �rst.

But if we use the �rst version of the sphere and apply smooth 
shading (Object>Shade Smooth) we get a more curved look to the 
object without adding more faces. This e�ect is achieved by 
adjusting the normals of the sphere.

In fact, the only visual clue to the sphere’s low face polycount is 
the straight edges on its pro�le.

However, if the sphere will only ever be viewed from a distance in 
our completed scene, the problem with the the pro�le disappears 
as seen below.

10 by 1 Grid Select 1 face Move up

Move up
Results identical

Select 10 faces10 by 10 Grid

Straight
edge pro�le

Same sphere
seen from a

distance
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The Shade Smooth option works well with the IcoSphere and Torus as we can see from the before and after pictures shown below. 

However, when we apply Shade Smooth to a Cylinder, the result 
looks wrong.

The trouble is that Shade Smooth is attempting to smooth out 
the whole surface of the Cylinder when all we want is to smooth 
out the vertical, curved section. Luckily, the Last Op Panel has a 
parameter for Shade Smooth that helps with the problem.

By checking Auto Smooth, Blender only smoothes out faces 
which are at an angle of 30o or less to each other  - the angle value 
can be changed. Since the top faces of the cylinder are at an angle 
greater than 30o to the side faces, we can achieve a better result.

We need to check the same Auto Smooth option when applying 
Shade Smooth to a Cone.

Original With Shade Smooth With Shade SmoothOriginal

Original With Shade Smooth Check this box
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